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Entering a Spanish Transcript
In this exercise, you will use the SALT editor to enter a short Spanish transcript and automatically identify the
word roots and reflexive pronouns.
A. Entering Diacritic Characters
The Spanish diacritic characters can be accessed several ways. The appendix at the end of this document
lists several options. Before entering the short Spanish transcript included in this exercise, make sure you
have a viable method for entering diacritic characters.
B. Begin a New Spanish Transcript
1. SALT begins with the Getting Started window. In this exercise, you will be creating a new transcript so
click the New button and you are presented with the “New Transcript” dialogue box. Note that selecting
“New” from the Getting Started window is the same as selecting File menu  New.
2. Enter sample header information including the child’s First name (you choose), Gender (you choose) and
Current age (7;2). From the second column, select the Sampling Context (Nar) and Subgroup (FGTD) for
Narrative retelling the story Frog Goes to Dinner. If you are not sure how to do this, refer to the exercise
titled “Entering a Transcript”.
3. Change the Target Language setting to Spanish.
4. Assume the target speaker is a bilingual (Spanish/English) speaker. Check the Bilingual box and make
sure SE (for Spanish/English) is selected. The bilingual setting will influence the database pre-selected for
comparison. Note that if the speaker is a monolingual Spanish speaker, you would change the Target
Language to Spanish but would not check the Bilingual box.
5. Click OK to close the header dialogue box and you are presented with a new transcript window. Note
that the Language plus line indicates SPANISH and the Bilingual plus line indicates SE (for
Spanish/English).
C. Type in a Short Transcript and Check it for Errors
1. Type in a short Spanish language sample.
•

Type in the eight sample entries as they are listed below. It doesn’t matter if you type in upper or
lower case. Be sure to start each utterance in the 1st column. There should be one blank space
between the speaker identifier (E or C) and the utterance. End each utterance by pressing the
<Enter> key. Begin the first entry on the line following the initial timing line (- 0:00).
E Dímelo por favor.
C No puedes.
E Recuerdas que el niño abrió la ventana?
C Y después el perro se cayó.
; 0:02
C (Y) y no sé nada más.
E Contínua.
C El niño dijo, "Rana, Rana, dónde estás"?
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2. Check for transcript-entry errors.
or select Edit menu  Check for Errors.

•

Click the check icon

•

You should be informed that there were “No errors or warnings found.” Press OK to continue.
Note: If you made errors while typing in this sample transcript, go back and correct them. If you’re
not sure how to use the SALT editor to position you at the point of each error, refer to exercise titled
“Entering a Transcript”.

D. Check the SALT Language Settings
At this point it is a good idea to check the current language setting to make sure it is set up correctly for
working with Spanish transcripts. The language setting affects five parts of the SALT program: 1) the
contents of the standard word lists; 2) the automatic identification of word roots, if associated root
identification files (RIFs) are specified; 3) the availability of the “Clitic Tables” option in the Analyze menu; 4)
the date format; and 5) the report labels.
The current language is displayed on the right-hand side of the status bar at the bottom of the main
window. By default, the current language is taken from the “+Language” entry in the transcript. The current
language should be “Spanish” because you selected “Spanish” as the language when creating this transcript
(Section B above).

2. Click the Reset button to return the Language settings to their default values (in case they were
changed).
3. The first column lists the built-in languages which include “English”, “Spanish”, “French”, or “<unused>”.
SALT gets the current language from the “+Language” entry in the transcript. If the “+Language” entry is
either missing from the transcript or contains some language other than English, Spanish, or French,
then the first language, “English”, is used.
4. The second column indicates whether bound pronominal clitics are marked in the language. The Uses
Clitics check box should be checked for Spanish (attached pronominal clitics are marked with a plus sign,
e.g., da+me+lo).
5. The third column indicates whether the Grammatical Category reports are available in the Analyze and
Database menus. Currently the grammatical categories algorithm is based only on English and should
not be checked for other languages.
6. The fourth column indicates whether the specified root identification file is active. The Active RIF check
boxes should be checked for the English Inflections RIF, the two Spanish RIFs, and the French Verbs RIF.
7. Click OK to close this dialogue box.
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E. Identifying Root Words and Reflexive Pronouns
For SALT to correctly analyze a highly inflected and pronominal language such as Spanish, root words,
plurals, and reflexive pronouns need to be identified. Rather than having to type in these codes during the
transcription process, SALT has an edit feature that automates this process. The following two Spanish word
files are used for this identification:
Spanish Verbs contains a complete list of over 469,000 verbs. The only verbs intentionally left out of the file
are “las”, “la”, “les”, “le”, “lo”, “una”, and “uno” due to their word form overlap with specific articles and
pronouns. This file may be used to identify the root forms of all the verbs in the transcript.
Spanish Nouns and Clitics contains approximately 1,300 of the words used most often to retell the Frog,
Where Are You? story. Because this is not a complete list, you should identify the plurals, diminutives,
superlatives, and bound pronominal clitics as you are typing your transcript. This file may then be used to
catch those you miss.
1. Read about identifying root words and reflexive pronouns.
on the toolbar near the top of the screen or press the F1 function key.

•

Click on the help icon

•

Click on “Root Identification |” under Specific Entry Conventions and read about using the vertical
bar “|” to identify root words in the Spanish transcription section.

•

After reading this section, click the Back tab near the top of the window.

•

Click on Reflexive vs Non-Reflexive Pronouns (Spanish) and read about using the [X] code to
identify reflexive pronouns.

•

Close the help window.

2. Identify root words and reflexive pronouns.
•

Select Edit menu  Identify Roots.

•

A dialogue box is displayed and the first word recognized by SALT as requiring a root word or
reflexive pronoun [x] code is highlighted in the transcript, in this case, “puedes”.

•

There is only one choice for the word root, “poder”, and it is highlighted in the dialogue box.
Sometimes, however, there are several choices for you to select from. There are three ways to
select the correct choice: 1) type the number on your keyboard that is displayed in front of the
correct choice (#1 in this case); 2) highlight the correct choice and click OK; or 3) double-click the
correct choice.

•

Type the number 1 on your keyboard (do not press the <Enter> key).

•

SALT automatically inserts a vertical bar “|” followed by the selected root word and choices for the
next word found are displayed in the dialogue box.

•

Select the appropriate root word for the next two verbs, recorder and abrir.
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•

The next word selected is the word se in the utterance “Y después el perro se cayó”. This word has
two options.

•

Type the number 2 to select the 2nd option, se[x] since, in this context, “se” is a reflexive pronoun.

•

The next word selected is cayó. Select “caer”.

•

Select the appropriate root word for the next verb, sé.

•

Note that the next selected word, the noun nada, is recognized as being both a noun “nada” and a
verb form “nadar”.

•

Select the noun form and notice that nothing is inserted after the word “nada”.

•

Continue selecting the appropriate root words for the rest of the words identified in the transcript.

•

After the last word has been identified, you are informed that the root identification process is
completed; click OK, and the Identify Roots window closes.

The Spanish transcript should now have all root words and reflexive pronouns identified.
Sample entries
E Dímelo por favor.
C No puedes|poder.
E Recuerdas|recordar que el niño abrió|abrir la ventana?
C Y después el perro se[x] cayó|caer.
; 0:02
C (Y) y no sé|saber nada más.
E Contínua.
C El niño dijo|decir, "Rana, Rana, dónde estás|estar"?
F. Save the Transcript File
Note: Although your transcript files may be stored on any drive or folder, the default transcript folder
is the folder first displayed when you open or save files. These exercises assume the default transcript
folder is the My SALT Data\Transcripts folder located within your Documents folder. This folder was
created the first time you ran the SALT program.
Note: You do not need this transcript for any of the other exercises. If you prefer not to save
this transcript, skip this step and go on to step 2 for instructions on printing the transcript.
1. Click the save icon
or select File menu  Save or File menu  Save As... and you are presented
with the “Save As” dialogue box. Unless you changed the default transcript folder, you are prompted to
save the folder in the My SALT Data\Transcripts folder within your Documents folder.
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2. Click in the “File name:” box and type the name of the transcript file. You may use any name you want,
perhaps the child’s initials and the date of the sample as YYMMDD (e.g. TK110315). The SALT transcript
extension “.SLT” will be automatically added to the end of the filename.
3. Click the Save button and your transcript is saved.
G. Print the Transcript in a Readable Format
1. Click the print icon
dialogue box.

or select File menu  Print... and you are presented with the “print transcript”

2. From the first section, select Suppress non-error [codes] to suppress the reflexive [x] code, and all other
non-error codes, from being displayed. Note that the list of error codes, by default, include codes that
begin with “EO”, “EP”, “EW” or “EU”. This error-code definition can be changed using the “Setup menu
 Lists  Current Code Lists” option.
3. From the first section, also select Suppress all root identifiers “|” to print the transcript without
including the root identifiers.
4. From the middle section, check Number the entries All entries, Located within… Entire transcript to
number all the entries in the transcript.
5. Click the Preview button to view the formatted transcript. Notice that the entries are numbered and
that the [x] codes and the identified roots are not included. This results in a more readable transcript.
6. If you want to print this formatted transcript, click the print icon
again or select File menu 
Print.... Because you are now printing a report document, not a transcript, you are presented with the
standard print dialogue box. Click OK to print or Cancel to cancel the print.
H. Close All Windows.

•

Select Window menu  Close All.
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Appendix: Character Sets
SALT supports the UTF-8 character set which includes all the Spanish and French characters.
Are these characters built into the SALT program? No, other character sets are not built into the SALT program
although they are accessible from within SALT in the following ways:
•

Windows® OS methods of accessing the diacritic characters
Method 1: Using the standard Windows® keyboard.
This is an easy method but may or may not work for you, depending on your operating system and/or
keyboard.
Hold down the CTRL key and type
Then type
(then release the keys)
' (single quote)
a, A, e, E, i, I, o, O, u, U, y, Y
` (back quote)
a, A, e, E, i, I, o, O, u, or U
: (colon)
a, A, e, E, i, I, o, O, u, U, y or Y
^ (caret)
a, A, e, E, i, I, o, O, u, or U
~ (tilde)
a, A, n, N, o, or O
, (comma)
c or C
Other character combinations are also available.

To get
á, Á, é, É, í, Í, ó, Ó, ú, Ú, ý, Ý
à, À, è, È, ì, Ì, ò, Ò, ù, or Ù
ä, Ä, ë, Ë, ï, Ï, ö, Ö, ü, Ü, ÿ, or Ÿ
â, Â, ê, Ê, î, Î, ô, Ô, û, or Û
ã, Ã, ñ, Ñ, õ, or Õ
ç or Ç

Method 2: Add the "United States International" input language.
This option involves adding an input language to your keyboard. It's a one-time setup and allows you to
switch between your default keyboard and the United States International keyboard.
Windows® 10: To add the US International keyboard in Windows 10, go to Settings from the windows icon at
bottom left. Click on Time and Language, the Region and Language. You should see English (United States)
... [assuming you are in US]. Click on it and a button labeled OPTIONS will appear. Click on the OPTIONS
button. Now you will see an option to ADD a KEYBOARD. Click on that and then scroll down the list until you
see United States International. Click to add it to your language bar.
Rather than provide instructions for each operating system, use the Windows help option to search for
instructions. Search for "add or change input language". Follow directions to add the "United States
International" keyboard located within the "English (United States)" keyboard.
Once the keyboard is added, there should be an icon added to your system tray, which looks like a small
keyboard. This icon allows you to switch between your default keyboard and the US International keyboard.
When the language setting is set for "United States - International" you can access most of the special
characters as follows:
Hold down the RIGHT ALT key and
type
a or A
e or E
i or I
o or O
u or U

To get
á or Á
é or É
í or Í
ó or Ó
ú or Ú

First type " (double quote),
To get
then type
u or U
ü or Ü
SPACE BAR
"
Note: to type the single or double quote in
your transcript, type the quote followed
by a blank space.
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n or N
ñ or Ñ
number “1” key
¡
slash key “/”
¿
Other character combinations are also available.
•

Mac OS method of accessing the diacritic characters
Using the standard Mac keyboard.
This is an easy method but may or may not work for you, depending on your operating system and/or
keyboard.
Hold down the <option> key and type
Then type
(then release the keys)
e
a, A, e, E, i, I, o, O, u, U, y, Y
n
a, A, n, N, o, O
` (back quote)
a, A, e, E, i, I, o, O, u, U
u
a, A, e, E, i, I, o, O, u, U, y, Y
i
a, A, e, E, i, I, o, O, u, U
a or A
1
Hold down the <shift> and <option>
keys and type (then release the keys)
?
Other character combinations are also available.

•

To get
á, Á, é, É, í, Í, ó, Ó, ú, Ú, ý, Ý
ã, Ã, ñ, Ñ, õ, Õ
à, À, è, È, ì, Ì, ò, Ò, ù, Ù
ä, Ä, ë, Ë, ï, Ï, ö, Ö, ü, Ü, ÿ, Ÿ
â, Â, ê, Ê, î, Î, ô, Ô, û, Û
å or Å
¡
To get
¿

3rd party software.
There are several free software applications, which may be downloaded to provide easy access to the other
character sets, e.g., www.onehourprogramming.com.

•

Using the “Edit menu  Insert Symbol” option in SALT.
The "Edit menu --> Insert Symbol" option in SALT allows you to set up a list of characters that can be
inserted into the editor using minimal keystrokes. By default, the list contains the non-standard keyboard
characters used for Spanish and French but this list can be edited to suit your needs. Select the “Help”
option from this dialogue box for details.

•

Use other word processor.
Alternatively, you may prefer to type the entire transcript in Microsoft Word or some other word processor
where other character sets are available. You can try to just cut/copy and paste the text from Microsoft
Word (or other word processor) into the SALT transcript window though this does not always work.
Alternatively, save the transcript as a text file and rename the text file with the extension .SLT (rather than
.TXT).

Also see the following SALT YouTube videos:
•
•

Inserting Spanish characters with Windows (4:38)
Inserting Spanish characters with Mac (2:58)

